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AR-837-ER/E/EE/EF/IW

1. Product Features

IP-Based Access Controller with LCD
AR-837-ER

® Supports dynamic graphic control and timely jump to
emergency events.
Support for elevator scheduling control.

 Built-in 125KHz and 13.56MHz induction frequencies

e Support Electrostatic Detection Equipment(ESD) and
Single-Person Entry and Exit Monitoring Equipment

RFID LCD Fingerprint Access Controller
AR-837-EF9DO

Supports dynamic graphic control and timely jump to
emergency events.
Support for elevator scheduling control.

Built-in Door Bell button / llluminated Keypad Design /
Weatherproof

Graphic Display Multi-Function Proximity Controller
AR-837-E/EE

® Supports dynamic graphic control and timely jump to emergency
events.

® Support for elevator scheduling control.
® Built-in 125KHz and 13.56MHz induction frequencies
IP-based controller supporting flush-mount and surface-mount

LCD Card Energy Saver
AR-837-W

Optional Voice Module / Backlit Button Design / Enhanced
Controller Splash-proof Design

Built-in 125KHz and 13.56MHz induction frequencies
Support for Standalone Deduction/Charge Functionality

2. Application

Elevator Timed Scheduling Control

> Software Manual - LiftControl

Dynamic Graphical Control and Real-time Jumping of Emergency Events

P> Example of Monitoring Access Control Doors and Emergency Doors via

701ClientSQL Graphic Animation

> Lift Control Application

P> BMS System & SOYAL Access Control Integration Solution

Mailbox/Locker Management Application

P Membership Storage and Consumption

Stored Value and Deduction Application Case

P> Electric Vehicles Charging Station with Balance Deduction Solution and

Management System

Parking Space Monitoring System

P> SOYAL Graphic Animation Case Sharing
— Smart Mailbox
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Access Controller

AR-837-E

AR-837-ER /

R = Built-in RTC 1 = Weatherproof

E/EE/EF/ W

AR-837 ]

Frequency Communication Color Additional Module
B = 125kHz _ B = Black Edge A = TCP/IP Module
D = 13.56MHz 1=RS485 O - Orange Edge P - POE Module
S =125KHz+13.56MHz
Product Category RTC Waterproof
ER = E Series

Language(LCD)
1 = English/Chinese

AR-837

Frequency Communication Color Additional Module
B = 125kHz _ B = Black Edge A = TCP/IP Module
D = 13.56MHz 1=RS485 1 Silver Edge P - POE Module
S =125KHz+13.56MHz
Product Category RTC Waterproof Language(LCD)
E = E Series R = Built-in RTC Q- herproof 1 = English/Chinese
Access Controller
AR-837-EE
AR-837
Frequency Communication Color Additional Module
B = 125kHz _ B = Black Edge A = TCP/IP Module
D = 13.56MHz 1=RS485 1 Siver Edge P = POE Module
S =125KHz+13.56MHz
Product Category RTC Waterproof Language(LCD)
EE = E Series R = Built-in RTC 1= Uil 1 = English/Chinese
Access Controller
AR-837-EF9DO
AR-837
Frequency Color Logo
B = 125kHz B = Black Edge N = No Logo
D = 13.56MHz 1 = Silver Edge X = Soyal Logo
S =125KHz+13.56MHz
Product Category Module Type Network
EF = E Series 9DO = Optical Module R = Roof Type
Access Controller

X = Standard Type

A = TCP/IP Module

V240403

01. How to Order
AR-837-ER
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AR-837-W
AR-837 EE XR 1 B1 X
Frequency Communication Color Additional Module
B = 125kHz _ B = Black Edge A = TCP/IP Module
D = 13.56MHz 1=RS3485 1 - Silver Edge P - POE Module

S =125KHz+13.56MHz

Product Category RTC Waterproof Language(LCD)
W = LCD Card Energy R = Built-in RTC 1l S T e 1 = English/Chinese

02. Function Description of Front Panel & Indicator

1.  System will automatically exit Programming Mode when inactivating for 30
Power(Green). OK(Green) seconds.
Alarm(Red) i Error(Red) 2. LED status indicates controller’s mode and status.
Arming(Green) . In processing(Green) OK (green) — blinking constantly when operating in Programming Mode
— or flashing an existed card in card learn mode, it comes 2 beeps

warning and LCD panel displays “Same Card: user address / card
Attendance/Duty Functions number”
Error (red) — invalid card with 2 beeps warning and LCD panel displays “Card
Press“1 time ” | Press‘2 times” Number Err!”

() Up Dutyon  |Break out — or in anti-pass-back mode, when violates the access, it comes one
(12 DownDuty off  |Break RTN beep warning and LCD panel displays “Anti-pass Error!”
(=) Left Overtime on|Go Arming (green) — arming on status
Right Overtime off|Return Alarm (red) — any abnormal condition occurs

3. Keypad will be locked up 30 sec. when incorrect pin code or master code is
@ Esc/ Qit Enter / OK constantly entered.

4.  Maximum error input of pin code and master code can be changed via the

software 701Server (default: 5 times)

; Networking :/and # interactively flash between the Month and DAY.
{12007 | WED Duty:0 [e.g.] 12/07——12/07

Stand-alone : No flashing [e.g.] 12/07
(«—Reference to picture)

03.Manu Tree

6. Quit

14 :49:04
“& SOYAL

1. Add/ Delete 2. User Setting 3. Parameters[1] | 4. Parameters[2] | 5. Tools

1. Add > Card ID 1. Password 1. Node ID 1. Auto Relock 1. Language . .
2. Add > RF Learn 2. Access Mode 2. OnOff OpenZone 2. Egress(R.T.E) 2. Master Code 7. Quit & Arming
3. Suspend > Address 3. Extend Options 3. Door Relay Tm 3. Miscellaneous 3. Master Range
4. Suspend > ID # 4. Single Floor 4. Door Close Tm 4. Force Open 4. Terminal RS-485
5. Delete > Address 5. Multi Floor 5. Alarm Relay Tm 5. Close & Stop 5. Ext.Comm CN11
6. Delete > ID # 6. Enroll Finger 6. Alarm Delay Tm 6. Anti-pass-back 6. Open Time Zone
7. Recover > Address 7. Delete Finger 7. Arming Delay Tm 7. Duress Code 7. Informations
8. Recover > ID # 8. Arming PWD 8. Password Mode 8. Clock Setting
9. Antipass Group 9. Factory Reset 0. UART Port CN9
A. Event Logs
9. Daily Alarm




04.Full Function Command Menu Table
Up

e Entering

AR-837-ER/ E/ EE/ EF/IW

Input */123456 #) or * |PPPPPP #)

— Access programming mode

1. Add/ Delete
1-1. Add -> Card ID 1
1-1-1
User Address:
00000 XXXXX
Range: (0-16383)

1-1-2 v
Set (User Address) Code:

00000  XXXXX
(1-10 Digital)

1-1-3 v

Set (User Address) Code:
00000:_XXXX
Range: (0-65535)

1-6. Delete > ID #
1-6-1
Set  Site:
00000:XXXXX
Range: (0-65535)

1-6-2 ‘l'
Set Code:
00000:XXXXX

Range: (0-65535)

2. User Setting
2-1. Password
2-1-1
User Address:
F3: PreV F4: Next
Range (0-016383)

2-1-2 v

Input PIN Code
Rang: 0000~9999

-2. Add -> RF-learn
1-2-1
User Address:
F3: Prev F4: Next
Range: (0-016383)

100 WV

Tag Uints (pcs)
Must be Sequence
Range: (1-016378)

103 WV

Close Tag
Into RF Area

1-7. Recover > Address

1-7-1
Input Start Address
Range: (0-16383)

172 ¥

Input End Address
Range: (0-16383)

2-2. Access Mode
2-2-1
User Address:
F3: Prev F4: Next
Range (0-163833)

2-2-2 ‘l,

0: Invalid 1: Card
2: Card or PIN
3: Card & Pin

2-2-3 (837EF) N4
Finger / Face
0: Must 1: Ignore
000000=0

[e.g.] The Default Value= 123456. If already changed the Master Code= 876112, input * 876112 #|

P.S.If no instruction is entered within 30 sec., it will automatically leave the programming mode.

1-3. Suspend -> Address
1-3-1
Input Start Address
Range: (0-16383)

132 WV

Input End Address
Range: (0-16383)

1-8. Recover > ID #

1-8-1
Set  Site:
00000:XXXXX
Range: (0-65535)
1-8-2 v
Set  Code:
00000:XXXXX

Range: (0-65535)

2-3. Extend Options
2-31
User Address:
F3: Prev F4: Next
Range (0-16383)

032 ¥

Is Guard User
0: NO 1:YES

233 ¥
Enable Antipass
0: NO 1:YES
Data: 1

2-4. Single Floor
2-4-1
User Address:
F3: Prev F4: Next
Range (0-016383)

042 Y
Set Single Floor
(Range: 01~64)
Clear the Others

Esc/Quit

1-4. Suspend > ID #

1-4-1
Set  Site:
00000:XXXXX
Range: (0-65535)
1-4-2 v
Set  Code:
00000:XXXXX

Range: (0-65535)

1-9. Antipass Group
1-9-1
Input Start Address
Range: (0-16383)

192 ¥

Input End Address
Range: (0-16383)

2-5. Multi Floors
2-5-1
User Address:
F3: Prev F4: Next
Range: (0-016383)

2-5-2 ‘l,

Select Range:
1:01-16 2: 17-32
3:33-48 4:49-64

2-5-3 ‘l,

0->NO 1->YES
Current Setting:
1000000000000000

V240403

Down

Enter/OK

1-5. Delete > Address
1-5-1
Input Start Address
Range: (0-16383)

152 WV

Input End Address
Range: (0-16383)

103 W

Enable Antipass
0:NO 1:YES
Data: 0

2-6. Enroll Finger (837EF)
2-6-1 (837EF)
User Address:
F3: Prev F4: Next
Range: (0-016383)

2-6-2 (837EF) v
Enroll Fingers ?
Range: (1-2)

1

2-6-3 (837EF) 1 4
Put 1st Finger Center

Image Pls
Scan Data ...

2-7. Delete Finger (837EF)
2-7-1 (837EF)
User Address:
F3: Prev F4: Next
Range: (0-099999)
000000

-3-
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04. Full Function Command Menu Table

3. Parameters [1]
3-1. Node ID
3-1-1
Input New NodelD
Range: 001~254
Current Data: 001

3-1-2 v

Main Door Number
Range: 000~255

3-2-3 ‘l'

WGH1 Port Auto Open
Zone Dis/Enable (0/1)
0

3-8. Arming PWD.
3-8-1
Input PIN Code
Range: 0000~9999
1234

4. Parameters [2]
4-1. Auto Relock
4-1-1
Main Controller
Auto Relock Door
0: NO 1:YES
0

4-1-2 v

WG Prot

Auto Relock Door
0: NO 1:YES

0

313 ¥
WG1 Door Number
Range: 000~255

3-1-4 v

Show WG Message
0: NO 1:Enable
1

3-3. Door Relay Tm
3-3-1
Main Door OpenTm
Range: 000~609
601~609=0.1~0.9
007

3-3-2 v

WG1 Door OpenTm
Range: 000~609
601~609=0.1~0.9

007
3-9. PIN&UID format
3-9-1
User PIN Length
Range: 4~8
4
392 ¥
Card UID Length
Range: 2~8
4

*kUser PIN Length Range:4~8(4 is default value) ; Card PIN Length Range:2~8(4 is default value)

4-2. Egress(R.T.E)
4-2-1

Main Controller

Request To Exit

0: Dis 1:Enable

0
4-2-2 v
WGH1 Port

Request To Exit
0: Dis 1:Enable
0

315 ¥
Enable DHCP
0:No 1:En 2:Exit
192.168.001.127*
0

316V

IP Address (IPv4)
192.168.001.127
192.XXX.XXX. XXX

3-4. Door Close Tm
3-4-1
Main Door Close
delay time (Sec)
Range: 000~255
015

W

WG1 Door Close
delay time (Sec)

Range: 000~255
015

3-9-3
Show UID :0=No
1=WG 2=ABA

3=HEX 4=WG26
5=ABA8
1

394 ¥
NFC 13.56MHz RF
0: Disable
1: Enable
1

4-3. Miscellaneous
4-3-1
Main Controller
TimeAttendance
0: YES 1:NO
0

432 ¥

WGH1 Port
TimeAttendance
0: YES 1:NO
0

233V

Main Controller
Skip PIN Check
0: NO 1: YES
0

3-1-7 N
Net Mask (IPv4)
255.255.255.000
255. XXX XXX. XXX

s1s W

Gateway (IPv4)
192.168.001.254
192.XXX.XXX. XXX

3-5. Alarm Relay Tm
3-5-1
Alarm Relay Time
Range: 000~609
601~609=0.1~0.9
015
3-6. Alarm Delay Tm
3-6-1
Alarm Output
Delay time (Sec)
Range: 000~255

3-9-5
RFID 125KHz RF
0: Disable
1: Enable
1

396 ¥
'#'is Door Bell
0: Disable
1: Enable
0

434 ¥
WG1 Port
Skip PIN Check
0: NO 1: YES
0

4-3-5 v

Main Controller
Pass any Tags

0: NO 1:YES
0

4-3-6 v
WG1 Port
Pass any Tags
0: NO 1:YES
0

3-2. OnOff OpenZone
3-2-1

Open Door Imm.
During Open Zone

0:No 1:Yes
0
3-2-2 ‘l'

Main Controller

Auto Open Zone
Dis/Enable (0/1)
0

3-7. Arming Delay Tm
3-7-1
Enter armed sta.
Delay time (Sec)
Range: 000~255
001

3-7-2 \l'

Armed Pulse out-
put time. (10ms)
Range:000~255
000

3-9-7

User Capacity:

0: 16384 1: 32768
2: 65536 (0~2)

0

398 ¥
Enable Buzzer

0:NO 1:YES
1

437 ¥
WGH1 Port
Share Main Relay
0:NO 1:YES
0
4-3-8 v

Tag Second time
interval (10ms)
Range: 0000~9999
0100

439 ¥

Max error times
for lock keypad
Range: (0~9)

5




4. Parameters [2]
4-3. Miscellaneous
4-310 b
Main Controller
On Egress Beeps

0: NO 1:Bi 2:Bibb
2

4-3-11 v
WGH1 Port
On Egress Beeps
0: NO 1:Bi 2:Bibb
2

4-7. Duress Code
4-7-1
Input PIN Code
Range: 0000~9999

5. Tools
5-1. Language
5-1-1
0: English (USA)
1: Chinese (TW)
0

5-2. Master Code
5-2-1
Input MasterCode
000001~999999
123456

5-5. Ext.Comm CN11
(837EF)
5-5-1 (837EF)
0: FP-Type 1: Lift
2: Vein2000 3:

AR-837-ER/ E/ EE/ EF/IW

4-4. Force Open .

4-5. Close & Stop

4-312 ¥ 4-3-14 837EF) Y 4-4-1 4-5-1
Lock Door Relay Main Controller Main Controller Main Controller
0: NO 1:YES Free Tag Always Force Open Alarm Close Door Stop
0 0:NO 1:YES 0: NO 1:YES Alarm 0: NO 1:YES
0 0 0
4-3-13 4 PR ¢ 452 V¥
Interlock to WG ? WGH1 Port WGH1 Port
0:NO 1:YES Force Open Alarm Close Door Stop
0 0: NO 1:YES Alarm 0: NO 1:YES
0 0

4-8. Password Mode
4-8-1
Password Mode
0: Addr. & PIN(M4)
1: PIN(M8) 2:M6
1

5-3. Master Range
5-3-1
Input Start Addr
Range: (0-16383)
000000

5-3-2 ‘l,

Input End Addr
Range: (0-16383)
000000

5-6. Open Time Zone
5-6-1
Set <F1~F4,#>: 01
00:00~00:00 ..
SuMoTuWeThFrSaHo
00000000

5-6-2 v

Time=00:00~00:00
Main Port (0/1):0
WG Port (0/1):0

5-6-3 ‘l,

Weekday: (0/1)
SuMoTuWeThFrSaHo
XXXXXXXX
00000000

4-9. Factory Reset
4-9-1
0: System Param.
1: User Setting

2: System & User
2

5-4. Terminal RS485
5-4-1
0: Lift 1: Host

2:LED 3:PRN
1

5-4-2 v

Baud Selection
0: 9600 1: 19200
2: 38400 3:57600

5-7. Informations
5-7-1
F/w Ver: 4.4T
Users: 00000
Messages: 00000
Press any Key ...

5-8. Clock Setting
5-8-1
YY: XXXX MM: XX
Day: XX  Hour: XX
Min: XX Sec: XX

5-8-2 v

Month/Day Format
0: DD/MM 1: MM/
DD

5-5. Ext.Comm CN11
5-5-1
0: Suspend 1:Lift
2: Voice 3: PRN
1

5-5-2 J’

0: 4800 1: 9600
2: 19200 3:38400
1

5-9. Daily Alarm
5-9-1
Set <F1~F4,#>: 01
00:00 Sec.=000
SuMoTuWeThFrSaHo
00000000

5-9-2 v

Start Tm=00:00
Effect Sec.=000

5-9-3 ‘l,

Weekday: (0/1)
SuMoTuWeThFrSaHo
XXXXXXXX
00000000

»* More Details : Introduction of New Function Commands for Enterprise E Controller and Home H Controller

5-5-3 ‘l'

5-0. UART Port CN9
5-0-1

5-0-2 v

5-A. Event Logs
5-A-1

V240403

4-6. Anti-passback
4-6-1
Main Controller
Anti-passback
0: NO 1: YES
0

4-6-2 v

WGH1 Port
Anti-passback
0: NO 1: YES
0

Elevator floor
button available
Range: (1~600)
000

0: Lift9600 1: PRN
2:LED  3: Voice
0

Elevator floor
button available
Range: (1~600)
015

20'06/04 2359:26

(M24)Controller
Power On 00000

6. Quit
7. Quit & Arming



https://www.soyal.com/news.php?act=view&id=273
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05. Programming

A. Keyboard Lock/ Unlock

e Lock/ Unlock
Press *) and #) simultaneously to lock keyboard. Press simultaneously again to unlock.

B. Entering and Exiting Programming Mode

o Entering

Input * /123456 #| or * |PPPPPP #)
[e.g.] The Default Value= 123456. If already changed the Master Code= 876112, input | * 876112 #| — Access programming mode
P.S.If no instruction is entered within 30 sec., it will automatically leave the programming mode.

o Exiting
Press the *| *| repeatedly — 6)Quit or 7 Quit and Arming (Please refer to alarm / arming setting)

e Changing the Master Code
Access programming mode — 5 |Tools — 2]Master Code — Input the 6-digit new master code — Succeeded

C. Initial setup

o Language Setting
Access programming mode — 5 |Tools — 1JLanguage — OJEN — Succeeded — Initial system...

* Node ID of Reader Setting
Access programming mode — 3 |Parameters[1] — 1/Node ID — Input New Node ID : 1~254 (default value:001) = Main Door Number : 0~255
— WG1 Door Number : 0~255 — Show UID (0=No, 1=WG, 2=ABA, 3=HEX) — Enable DHCP(0:No, 1:En, 2=Exit) > Succeeded

D. Adding and Deleting Tag

% User capacity: 16384 (00000~16383)

Tag Information

a
0000848785
uogeszzize;— CARD CODE (momeeerss _ggesnse—CARD CODE
SITE CODE SITE CODE

¢ Adding Tag by Tag ID
Access programming mode — 1JAdd/Delete — 1]Add -> Card ID — Input 5-digit user address — Input Site Code — Input Card Code

o Adding Tag by RF Learn Function
Access programming mode — 1)Add/Delete — 2]Add -> RF-Learn — Input 5-digit user address
— Input Tag Units(pcs) — Close Tag into RF Area

XIf the batch of tags are Sequential, input Tag Units(pcs) in the quantity of the tags and present the tag with
the lowest number to the controller for adding all the tag data; otherwise, the tags must be presented to the controller individually

o Suspend User Address
Access programming mode — 1JAdd/Delete — 3 JSuspend -> Addr — Input Start address — Input End address

» Suspend Tag by Tag ID
Access programming mode — 1)Add/Delete — 4 |Suspend -> ID # — Input Site Code — Input Card Code

o Recover User Address
Access programming mode — 1)Add/Delete — 7 |Delete -> Addr — Input Start address — Input End address

o Recover Tag by Tag ID
Access programming mode — 1JAdd/Delete — 8 |Delete -> ID # — Input Site Code — Input Card Code

o Deleting User Address
Access programming mode — 1JAdd/Delete — 5 |Delete -> Addr — Input Start address — Input End address

o Deleting Tag by Tag ID
Access programming mode — 1JAdd/Delete — 6 |Delete -> ID # — Input Site Code — Input Card Code

o Setting up the access mode
Access programming mode — 2 |User Setting — 2JAccess Mode — Input User Address — 0: Invalid; 1: Card ; 2: Card or PIN; 3: Card & PIN




E. PIN Code

AR-837-ER/ E/ EE/ EF/IW

V240403

Access programming mode — 2 |User Setting — 1 |Password — Input 5-digit user address — Input 4-digit PIN (0001~9999) — Succeeded

Or via 701Client set it on Users screen

F. Adding / Deleting Fingerprint
Adding

Access programming mode — 2 |User Setting — 6 |Enroll FP — Key in 5-digit user address —1 or 2 different fingers on the sensor lens — Succeeded
P.S. The AR-837EF(9000DO) needs to collect twice for each fingerprint ; however, AR-837EF(1500D0O) needs to collect three times for each fingerprint.

Deleting

Access programming mode — 2| User Setting — 7 | Delete FP — Key in 5-digit user address — Succeeded
P.S. If you want to delete all users’ FP, key in 99999 #

G. Access Mode

% Control mode can be set on hardware or software.

Hardware settings:

Access programming mode — 2JUser Setting —
2 | Access Mode — Key in 5-digit user address
(00000~08999) — 0: Invalid; 1:Card; 2: Card or
PIN; 3: Card and PIN

(837EA: — Finger Identify: 0: Must ; 1: Ignore )—
Succeeded

% If you select the access mode with PIN,
please ensure the parameters in

4 | Parameters [2] — 3| Miscellaneous —
Main Controller Skip PIN Check, select 0 to
disable WG1 Port Skip PIN Check, select 0 to
disable; It will mistake Controller and cannot get
access if you select different access mode in 2
Access mode and 3 |Miscellaneous

Software settings:

Enter 701ClientSQL — User Card edit — Set
Access Mode

For detailed settings, please refer to the
701ClientSQL manual

Chapter 2-6 User Card Edit

H. Arming Password

Access Mode

Finger Identify
(837EF/EA Only)

Result (837EF/EA Only)

Hardware 701Client Hardware 701Client
0: Must Just card
’ Just Face / FP
0:Invalid Invalid User
11 M Just card
: Ignore
9 M Just Face / FP
0: Must D g ot card Face+Card
' []Just Face / FP
el |._ Just card Card -first, then Facepfint. )
1:Card 0: Must 1 Just Face / FP Special firmware version (For requirements, contact SOYAL).
ard or PIN u
Gard anc Sl APSB837EF___V0405_230512 5-£F BIRIEM.STM
11 M Just card 1. Card Only
F18NOre | 1 Just Face / FP | 2. Face Only
Just card 1. Face+Card 2. Face+PIN 3. Card+Face+PIN
OMuSE Just Face / FP | 4. Card+Face+Card 5. PIN+Face+PIN 6. PIN+Face+Card
e M Just card Card first, then Faceprint.
3 i u
PINar Y g‘;:'zn, 0: Must Just Face | EP Special firmware version (For requirements, contact SOYAL)
Card or PIN APS837EF___V0405_230512 5. KA HBIRIER.STM
Card and PIN
Just card
1: Ignore M 1. Card Only 2. PIN Only 3. Face Only
N Just Face | FP
Just card
~_10: Must ustcar Face+Card+PIN
3:Card Invalid Just Face / FP
and PIN Gord only M Just card
% 1: Ignore 1. Card+PIN 2. Face+PIN
Card and PIN 9 M Just Face | FP

Access programming mode — 3| Parameters[1] — 8] Arming PWD — Input 4-digit PIN (0001~9999; Default: 1234) — Succeeded

Or via 701Server and set it on AR-829E screen

I. Arming Delay Time

Access programming mode — 3] Parameters[1] — 7 JArmingDelayTm — Enter armed sta. Delay time(Sec), Range:000~255;
Armed pulse out-put time (10ms) ,Range : 000~255 — Succeeded

J. PIN & UID Length setting

Access programming mode — 3| Parameters[1] — 9 |PIN & UID format — User PIN Length Range:4~8(4 is default value);

Card PIN Length Range:2~8(4 is default value)

K. Duress Code

Access programming mode — 4 |Parameters[2] — 7 |Duress Code — 4 sets (select one) — Input 4-digit PIN (0001~9999) — Succeeded

Or via 701Server to set it on AR-829E-V5 screen

XDuress Code is only available in networking mode. It will substitute a personal pin code and send the message of Duress to computer as a warning signal.
*The Duress Code 0000 means that disable Duress Function and the default value is set as 0000 already.

L. Terminal Port

Access programming mode — 5 |Tools — 4 Terminal Port — 0:Lift ; 1:Host ; 2:LED ; 3:PRN (default value:1) — Baud Selection

(default value:9600) — Succeeded
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M. Setting up the alarm / arming

In the security management of access control system, the controller or reader status is divided into Standby Mode or Disarming Mode and Arming
Mode. The conditions for triggering the alarm in these two modes is different, as shown in the following comparison:
e Alarm conditions: o Application:
1. Door is forced open 1. Door open too long: Door is open longer than door relay time plus door close time.
2. Force open (Opened without a valid user card): Access by force or illegal procedure.
3. Door position abnormal: Arming is enabled and the power is suddenly off then on.

Dlsarmlng Mode Arming Mode

Triggering Alarm Triggering Alarm
Condition: Condition:

i & o L L @ i

door is forced abnormal door door open too door is forced
openg position Iong openg

o Arming Setting and Alarm Trigger Procedure :

1.Normal Opening N NP NP
ES e e
Green Led Flash ~ Green Led Flash Quickly Red Led Flash Quickly

Enable Arming IArmmg Delay TM @ @ Door Relay TM l @ Door Close TMI @Alarm Delay TM| @ Alarm Relay TM

N~ Standby Mode : Door open ¢ ~Alarm trigger
(Arming is not enable) Enable Alarm Trigger
Arming Status

2.Abnormal Opening

N L, L,
A %S %
Green Led Flash Green Led Flash Quickly Red Led Flash Quickly
Enable Arming IArmmg R © (Y Alarm Delay T™ | ® Alarm Relay T™
Standby Mode : Alarm trigger
Arming is not enable Enable
( g ) Arming Status Alarm Trlgger
» Enable Arming status:
Standby Mode
Card only Card or Passcode Card and Passcode
Enable all devices Enable particular device Input 5 digit user address — Input 4 Induct valid card — Input 4 digit pass
Induct valid card — Input 4 digit Induct valid card — Input 4 digit digit pass code — #] — Input 4 digits |code — #)— Input 4 digits arming
arming code — %) * #J arming code — */0or 1 #/or #)  |arming code — *) *) #)or *|0 or 1 #|code — * | *|#)or *)0or 1 #
Enter Program Mode
Enable all devices: Access programming mode — *| *| #| Enable particular device: Access programming mode — *| * |0 or 1 #)

o Disable Arming status:
Standby Mode

Card only Card or Passcode Card and Passcode

Disable all devices Disable particular device Input 5 digit user address — Input 4 Induct valid card — Input 4 digit pass
Induct valid card — Input 4 digit Induct valid card — Input 4 digit digit pass code — #) — Input 4 digits \code — #)— Input 4 digits arming
arming code — *| 9 #) arming code — */0 or 1 #)or #) |arming code — *) 9)#Jor *)0or1#|code— *) 9)#|or *|0or1 #)

2% Factory default armingcode is: 1234. 0 or 1=Reader unit (0=Main Controller Parameter Setting,1=WG Input Port Parameter Setting ).
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° Enable/Disable the arming status:
Standby Mode
Card only Card or PIN Card and PIN
Open the door No open the door Input user address — Input Present the tag to reader — Input
Present the tag to reader — Input %|— Input 4-digit arming PWD | 4-digit individual PWD — #| — | 4-digit individual PWD — #
4-digit arming PWD — # — Present the tag to reader Input 4-digit arming PWD — #) | Input 4-digit arming PWD — #

Access Programming mode
Enable: Access programming mode — 7 |Quit & Arming Disable: Access programming mode — 6 JQuit

% [Use FP] can substitute for [Induct valid card].

N. Anti-pass-back

While connecting with AR-721-U, AR-737-H/U(WG mode) and AR-661-U for anti-pass-back function, the access mode must be "Card" only.
* Device enable
Access programming mode — 4 |Parameters[2] — 6 Anti-pass-back — master controller select [1: Yes] — WG select [1: Yes]

e Card user enable
Access programming mode — 1 Add/ Delete — 9 |Antipass Group — Input 5-digit starting user address — Input 5-digit ending user
address — must select [1: Yes]

O. Lift control
[e.g.] Connect with AR-401RO16B to control which floor the user will be able to access. (BAUD9600)

o Setting Lift control
Access programming mode — 9 JTools — 4] Terminal Port — 0: Lift Controller — Baud Selection 0: 9600

Access programming mode — 5 JTools — 5 Terminal Port — 1: Lift Controller
(need to use 725L485)

Set Floor/ Stop
1. 2 3 4 5
1 0 0 0 0|0
17 18 19 20 21 22 5
2,0 0 0/ 0 0 O O 0
33 34 35 36 37 38 39 40 41
3/0/0/0 0 0 O O 0O
57
0

10 11 12 13 14 15 16
0 0 0 0 0 1
6 27 28 29 30 31 32
0 0 0 0/0 O O
42 43 44 45 46 47 48
0 0 0 00

7
0
2

49 50 51 52 53 54 55 56
4/0 000 0 0 00

9 60 61 62 63 64
0/0 0 00 O

» Single floor
Access programming mode — 2 |User Setting — 4 Single Floor —
Input 5-digit user address — Input single floor number: 1~64

e Multi floors
Access programming mode — 2 )User Setting — 5 JMulti Floor — Input 5-digit user address — Select range: 1 or 2 or 3 or 4 — Input 16 digits
multi floors number [0:disable, 1: enable]
[e.g.] Set NO. 114, can use it through the 8 F and 16F:
Access programming mode — 2 |User Setting — 5 |Multi Floor — 114 #| — 1 #) — 0000000100000001 #

P. Alarm Clock (for Factory)

Access programming mode — 5] Tools — 9/ Daily Alarm — Set (00~15) — Set Start Tm (24 Hours) ; Set Effect Sec.
(Seconds as the bell time, Range:1~255) — Set Weekday (0:disable, 1: enable) — Succeeded

o Hardware installation

POWER |+ o
12vDC |-
DC 12V Relay Board - m\
1]
2]
3]
[ [ 5]
"""""""""""""""" Mike device :
: Music Box : : p—6| [ALm
1 Horn ' ! 12y
: 2 : i M2 M 5] |ono
H ——o-—| Board : - oD
: T Wikes Soandwie | Music Box | ——lomtroller J
Mike device =222 Output to M1 and M2
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Q. OpenZone

Access programming mode — 3] Parameters[1] — 2)OnOff OpenZone — Main Controller Auto Open Zone (0:disable, 1:enable) —
Open Door Imm. During Open Zone (0:No, 1:Yes) — WG1 Port Auto Open Zone (0:disable, 1:enable) =~ Open Door Imm. During
Open Zone (0:No, 1:Yes) — Succeeded

R. Open TimeZone

Access programming mode — 5)Tools — 6 |Open TimeZone — Set (00~15) — Time (24 Hours) ; Main Port (0:disable, 1: enable) ;
WG Port (0:disable, 1: enable) =~ Weekday (0:disable, 1: enable) — succeeded

06. Firmware Upgrade

Get the upgrade software from SOYAL or our distributor and run “UdpUpdater” software

010

o Execute the software @Qﬁ The software is Login the SOYAL web to downloads

AR Skl
‘; |
NET Adapter 192.168.1.21; f0-79-59-62-fa-23; (Realtek PCle GBE Family Controller #3) E
Fimware | I’Gxoooo Load FW. Update FIW
LCDFont | Load Font Jpdate Font
Idle Image ‘ Load Image. Update Image
727cMi0Test | [00 [13 |[57 [[o1 |[oz [[o3 | |mACRTC SublPRange 127 |- 130 | Scan Exit

o
o Ethemet 1P |192.168.1.127 Port 1604 |Node |1 |crm pd

O Serial Node (COM) 1 comi « v 1 | AR33IE T25Ev2 ) |l v © | O 8% ARBIETSER
HAEE - FERHK - 0@
Serial Port (COM) BAUD >
- s - - " - o RE a wHAS 2 KA
(115200 ®)57600 () 38400 () 19200 ()9600 (4800 e ~
= | APST25Ev2_V0404_220914.5TM 2022/9/14TF0.. STMMmE
Select Device By
O721v2 2. SSD120GB (C)
— <~ ATBM)
~- New Data (R)
(101/321/401/721/723725/888 H-K-U —arm « Temp (T)
@ A
 DESKTOP SABF aE gl
= SOYALO02GRAC
= SOYAL236EDD\:
N SOYAL379ADA
[FONTROLLER(192:168.001.172)- Y rmware Update is Completed | 3 SOYAL394CIND
T 3 SOYAL132AND
 SOYALS10RICKI
Default boot loader address is 192.168.1.128 (1604) |
2 SOYALDSMALL : !
| mxsi3cm v o< >
BEAEN): [APST25Ev2_V04042209144TM | Hirmware iles(*.stm;*at3~uil
FREX(O) A
_

e Update the firmware
[Please login the SOYAL web to download the new ISP Firmware.]
1. Input the Target Address and Port 4. Click [Update Device] to start the firmware update

2. [Load F/W] open the documents that have the new ISP Firmware 5. Till the screen shown [Firmware Update is Complete]

3. Click the new ISP Firmware and [Open] it
»* More Details : Software Manual - UDP UPDATER

07.Restoring Factory Settings

Reset all device parameters and user card data

» Reset all device parameters and user card data:
Access programming mode — 4 | Parameters2 — 9 |Factory Reset =0 : System Param ;
1 : User Setting ; 2 : System & User

* Reset IP Setting:

When the device's power is on, press the [RESET] button on the main board untill the ERR (Red)
LED of screen lights up. (Refere to the picture beside)

1% After operation as above, you will hear a long reminder sound,and wait until the sound disappears,
i and then reset the power of the controller. The device will be restored to factory settings.

1% After having done the "Factory Reset," the External Communication Port must be reset. Or

: the biometric sensor won't be functional.

5/Tools — 5| Ext. Comm Port (0:FP-200 ; 1:Lift ; 2:Vein2000 ; 3:FP-9000 ; 4:Reserved )

-10 -
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08.IP Setting

o Open your Web Browser and input factory default IP
address: http://192.168.1.127

If the IP address of AR-837 (E/EE/ER/

/€ S2E - Windows Internet Explorer

mE]

[& npamszisar sz |

@[] (%] [x] [cooz
BOREQ IAD HEM B

e
& -

B H & EEe- GIR0-

EF) has be changed, we must enter the
new IP address.

Y P'\ﬂr\ mAaAmr

Current State Monitor the on-line computer

MNetwork Setting [€——— IP Setting

|User Password [€«————————— Change the Log-in information

o Current State
Online Status is able to monitor and
show which computer is linking on Ethernet Module

Show which computer is linking
on Ethernet Module.

Current IP address

¢ Log-in User Password

Log-in window will pop out and please input
% At the Factory Default
User name: SuperAdm / Password: 721568

NOTE :

Current State

Network Setting

User Password

AR-725E-V2 Access Control

Ver1.09
ACCESS CONTROLLER

Current IP Addresses

Remote P (Port) State
192.168.001.052:(0080) CONNECTED
192.168.001.052:(0080) CONNECTED
Name  [Type IP address

etl |Ethernet

Subnet mask Gateway

Current IP Addresses.

52168 007 052 (0080) GONNEGTED
102 160 001.052(0000) CONNECTED

Current State

Nefwork Setting

User Password Gateway

Name A Type P address
ett Ethernet 5

When you choose the "Networking Setting" or "User Password" at first.

® User Name is different from old and new version, password can be modify via [User Password]

Authentication Required

http://132.168.1.127 requires a username and password.

Your connection to this site is not private.

[DHCP

DHCP

click “Update” button. After updating the IP, please re-
connect the Web Browser by the new IP address.

e User Password
Change the log-in password to lock the IP setting of
Ethernet Module.
The password is composed of 10 characters at most which
can be either A~Z or 0~9.

Current State
etiwork Seffing

User Password

setting on the list but will not be change from updating new version. If you forgot the password, RESHERG Bttt
the solution is pressing Reset Button to reset it as default value. Passwond: | 721566
e R, O
-Lng In Cancel
After 2020/01/21 SuperAdm | Default Password : 721568 or self-definition - -
Before 2020/01/21 admin Default Password : admin/ password not required or self-definition
» Networking Setting
€ SIE - Windows Internet Explorer
You will find initial IP Address 192.168.1.127 and check < IS}d CTTYeTH E— = Ole](9]{xq] [5oze .
L. . . ﬁX;ﬂ_Tl #HE ﬁi\!‘rf HBEW IAD AW
MAC Address is identical to the sticker on Ethernet Module & @ (s =] B-85 - 8EE0-GIAL-
device. Please alter the IP address as you want, and then AR-725E-V2 Access Control o

Network Setting

After you have changed the IP address, the device will restart (hardware reset)
‘You need to change the host IP with new IP Address in Internet Browser to re-connect the target.

item Setting
Device Name [CONTROLLER. |

LAN IP Address M]

LAN Net Mask [se2ps250

Default Gateway
Primary DNS Server
Secondary DNS Server
MAC Address

DHCP Client

TCP Listen Port

o
\1521'1(1 024~9999)
Tpdate

ACCESS CONTROLLER

7 S5 - Windows Intemet Explorer [®E]
@ﬁ + | & npnaziset 1ow ®e][#2] x| [gon B
BED WSRO AR SOREWL IAD HSD B - T g
& (g = B8 &-omE-gIEe-
AR-725E-V2 Access Control Ver109 %
ACCESS CONTROLLER
User Password Setup
Current State New Password
Network Sefting Password Again
User Password I

-11 -
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09. Notice

malfunction in the

reader.

1.Tubing: The communication wires and power line should NOT be bound in the same conduit or tubing.
2.Wire selection: Use AWG 22-24 Shielded Twist Pair to avoid star wiring, CAT 5 cable for TCP/IP connection
3.Power supply: Don’t equip reader and lock with the same power supply. The power for reader may be unstable when the lock is activating, that may cause a

The standard installation: Door relay and lock use the same power supply, and reader should use another independent power supply.

Connector Table (1)

Cable:

Cable:

Wire Application |Wire,  Color
1
2
3 |Orange White
4 Orange
TCP/IP Output 5 | Green White
6 Germ
7

Wire Application  Wire Color Description
Anti-Tamper Switch 1 Red N.C.
2 Orange COM
3 Yellow N.O.
Cable: Main Port
Wire Application  Wire Color Description
Lock Relay 1 Blue White | (N.O.)DC24V1Amp
2 | Purple White |(N.C.)DC24V1Amp
Lock Relay COM 3 White (COM)DC24V1Amp
Door Sensor 4 Orange | Negative Trigger Input
Exit Switch 5 Purple Negative Trigger Input
Alarm Relay 6 Gray N.O./N.C. Optional (by jumper)
Power 7 | ThickRed DC 12V
8 | Thick Black (DC 0V
Connector Table (1)
Cable: WG Port
Wire Application | Wire Color Description
Beeper 1 Pink Beeper Output 5V/100mA, Low
LED 2 Yellow Red LED Output 5V/20mA, Max
8 Brown Green LED Output 5V/20mA, Max
. |Transistor Output Max. 12V/100mA
RO “ | BlueWhits (Open Collector Active Low)
5 | Thin Green Wiegand DAT: O Input
Wiegand ; ;
6 ThinBlue Wiegand DAT: 1 Input
WG Door Sensor 7 Orange | Negative Trigger Input
WG Exit Switch 8 Purple Negative Trigger Input

Connector Table (2): Optional

Cable: Cable:
Description | \Wire Application |Wire| Color |Description @ Wire Application Wire, Color Description
- \oice Module 1 Black |DC 0V HID RF Module 1 Orange |ANT 1
(‘Required speaker | 2 | Yelow |TX 2 | Puple ANT2
Net - TX+ 8Q/1.5W (Max. 3 White |TE 3 Black |DC 0V
Net-Tx- || 4 | Orange RX 4 | Red DC5V
Net - RX+ 5 Blue |Wiegand DAT: 1 Input
Net - RX- 5 | Red DC5V 6 | Green |Wiegand DAT: O Input
- 6 Blue | -- 7 White -

10. Connector Table

s I N)
8
7
6
5
4]
3]
2]
1]
Bl )
Cable:
Wire Application | Wire Color Description
RS485 for Lift 1 | Thick Green |RS-485(B-)
Controller 2 | ThickBlue |RS-485(A+)
Cable:
Wire Application  Wire Color Description
Reserved 1 Red --
Security trigger signal 2 Purple Security trigger signal Output
Arming 3 Red White |Arming Output
Duress 4 | Yellow White 'Duress Output

Cable: [#\ kK]

Wire Application  Wire

1
Door Bell

2

% AR-837-ER does not support the CN13 doorbell output function, and the doorbell function can only be triggered through the # key by enabling it using command
3-9-6. When using this special method, the output point is the CN4 alarm output gray wire.

Color | Description
.. Transistor Output Max.DC12VDC/
Black White | 1 ma (Open Collector Active Low)
Black |DC 0V

-12-
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11. Wiring Diagram

Connect to Electric Bolt Connect to Magnetic Lock

BP-W12-2000
Controll +| POWER
ontrolier N——1-] 12VDC Magnetic Lock
) R Controller | — AR-0600M-270
Main Port 12V
:
1 = E Electric Bolt
NC. P.T Bt AR-1207A T POWER
oM 3 CE07ALY — _12VDC
PB o ) LM\ BP-W12-2000
Sensor
: AR-MS-101-A A =
g \_T_N.O. Push Button
\ WG Port CNPE no. [° I °|_ @| AR-PB5
@ Push Button P, o
) F AR-PB5 com L=
COM °
+ POWER
+|POWER -| 12vDC
—/12VDC
BP-W12-2000
BP-W12-2000

Connect to Electric Strike Door Open Too Long Alarm Wiring Method (External Sensor)

12v
b ntroller
Controller Controlle (clsavar)o
GND Electric Strike ( . \ o[SovaL)
- AR-YS-130NO Main PEIE I
Sensor
+| POWER AR-MS-101-A
_,7} 12VDC
BP-W12-2000
Alarm
ﬂ N.O. bell
Push Button
n AR-PB5
COM
% POWER
% POWER -] 12vbc
—| 12vDC BP-W12-2000
BP-W12-2000
Tamper-Switch Alarm Wiring Method Tamper-Switch Alarm Wiring Method
(Simplified Peace of Mind Type-WG Port Sensor Wiring Method) (Centralized Monitoring Type with Assurance(RS485)-Connect to Central
Monitoring System through Modbus via Universal I/O Module)
Controller 8- = Controller P.T.Exit Electric Bolt
) S
~ N = pPText | Electric Bolt OMN— AR-1207A
CN5 Maliort v AR-1207A (5 Main Port ) GND
GND WG 2] BP-W12-2000
Port —
> N.C. 1+|POWER
5 coMm |1~ 12vDC
'y Door Contact| 4 Alarm
N 5: g ; ALM [ N—o E@ bell
! Alarm bell 12V|4
il 8 +] POWER
o | o e—T——1-] 12vDC
3 | +| POWER v Buiitin BP-W12-2000
o3 Built-in _ ~| 12vDC _ Tamper Switch /
{ Tamper Switch_/ 5 Universal I/0
BP-W12-2000 o— GND Module
v AR-403-10
SCADA
% Enable [Share Door Relay] & WG Port option usB RS485
[Enable Force Alarm] via Parameter Setting of Central Monitoring 5 Enable WG Port option [Enable Force Alarm]
701Server Software System

via Parameter Setting of 701Server Software

-13-
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Tamper-Switch Alarm Wiring Method (Cloud Monitoring Active Reporting Type-TCP)
Controller " — Electric Bolt
LEXI =
-IIO Moc{ule cns i e T ] AR-1207A
AR-727CM-0804R GND
e t2 BP-W12-2000
Cﬁ} S N 1T TroweR
g Kz -
50 - pnonon - 12vbe
n ol = Alarm
M o -
Central Monitoring o bell
System
POWER [} _
12vDC [+ +| POWER
BP-W12-2000 ong ° =) 12vDC
BP-W12-2000
Strengthen security with AR-721RB Connect to Reader
BP-W12-2000 BP-W12-2000
12V —
_ 12V 12V — =\ |+ [+| POWER
° o sovar e + GND GND i POWER - —|GND - -| 12vDC
| - =1 12vDC Electric Bolt P.T.Exit — =
Electric Bolt AR-1207A E — |5 =
AR-1207A NC. —— 'E | Electric Bolt
) Bz  Main Port AR-1207A
2RieD (YA
Controller GLED NEdY
Door Output §§ S (O[SeVALI0)
n K%n PB ) [X) GO n M- @E
\ CN4 Relay Output Module 51 ] Door Sensor
g AR-721RB Relay Output Module AR-MS-101-A
X AR-821RB G-DS S
] . com | °
Y 7 21+ .
I
— 1 eony  ONDEIHS &
A N.O. °
\__Controller ) Push Button
POWER [+] 12 M AR-PB5
GND Reader N —————
12VDC || Push Button ¥ 8 - R— 3] POWER
BP-W12-2000 AR-PB5
=] 12vDC
BP-W12-2000

Enable "Share Door Relay" to open the same electronic lock regardless of whether it is triggered by the main controller or the Wiegand reader. This is achieved by using the NO contact of the blue-white wire in

CN4, suitable for systems where the controller and the reader control the same lock.

Disable "Share Door Relay" for card swiping on the main controller, triggering the NO contact of the blue-white wire in CN4. For card swiping on the Wiegand reader, triggering the NO contact of the blue-white

wire Door Output in CN5 WG Port. This allows the main controller and the reader to independently control two electronic locks.

WG Mode / Controller Mode Setting Method ,AR-725-E become WG mode (28 */000 #))

WG mode with attached reader(Slave)
701ServerSQL Parameter Setting

Controller Mode(Master)
701ServerSQL Parameter Setting

Close Stop Alarm O O [_] Alarming on Expiried Access Close Stop Alarm O o [[] Alarming on Expiried Access
Sy - T o] Osswcosmaunos
[ CN5 837-E/EE/EF/ER \

-

837-EIEE/EFIER\

Buzzer Output

WG Port |

-

2 | RLED Output
GLED Output

Door Output

DSS(GLED Input)
PB(RLED Input)

S 13 CN4|
g Main Port) )
(Buzzer Input) — BP-W12-2000
,l 12v % POWER
£ GNDJ— 12vDC

(The main controller and reader must be grounded together.)

1. AR-725-E can be set up as WG26/WG34/
WG64 while the Controller is in WG Mode.
These Controller can also be paired with the
Controller that has WG input function.

2. Networking Setting: Select E Series Controller
Parameter Edit in 701Server.tick up the function
“Ev5 WG out/Hv3 Lift out”

3. Please restart the controller after pressing
“Write to Controller”.

%Using Rule :
Finger : Both 725-E Master mode and 725-E

WG mode must store all the same FP data and
real or visual card number.

Card : Can pass WG message to controller.

% Please refer to the FAQ for software
configuration instructions: How to set the E
Series card reader to Wiegand output mode?

¥FAQ : How to setup biometric controller of AR-
837EF/AR-837EA as weigand reader and enable
Anti-Pass back function?

- 14 -


https://www.soyal.com/faq.php?act=view&id=903
https://www.soyal.com/faq.php?act=view&id=903
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12. INSTALLATION

AR-837-E
8.6 mm
85 mm
425 mm 16. mnj/ 25 mm
pr—
3 c <
[ABO.W m \
A U
. 60.3[mm
& |IEL(E l S
3| |0 &
3 N & 3
3
41.3 mm
r——Dv4-76
R\ - \
20 mm 3765 < 40 »> -
07 ! 20 mm (Digging depth))
* Surface mounting hole(Front View) « Surface mounting hole « Flush mounting hole
e Flush mounting hole(Front View) (Side view) (Side view)
AR-837-EE/EF/W
133.45 mm 29.6 mm
128 mm 48.9 mm
66.7 mm 64 mm
) ~\ rr——
A A (
) @ ) A I
w
5 £ 60.3 mm
= £ o
Sy L w© = o] &
A NI - 5
g 3 |;| =
= [«—>
3 19.8 mm l
3 o
N 3 i .
4-06
4-955 60 mm 25mm 403 mm o depth)
+ Surface mounting hole(Front View) « Surface mounting hole + Flush mounting hole
e Flush mounting hole(Front View) (Side view) (Side view)
AR-837-ER
108 mm | 30 mm
IS
1S
» Surface mounting hole(Front View) » Surface mounting hole (Side view)
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13. Installation (AR-837-E/EE/EF/W)

A-1.Surface A-2. Embedded B. A-1.Surface Mounted: Use a screwdriver to screw the mounting plate
Mounted

to the wall. A-2.Embedded: To dig a hole for 837-E:85mmx113mm /
837-EF:128mmx109mm; and then, use a screwdriver to screw the
mounting plate to the wall.

Pull cable ends through the access hole in the mounting plate.

Attach AR-837-E or AR-837-EF to the mounting plate and install
screws (supplied) into the holes at the bottom with the allen key.
Apply power. LED (green) will light up with one beep.

14. Contents
AR-837-EF:Fingerprint
@ Products @ Terminal Cables ©® Tools © Optional

Ethernet : DMOD-NETMA10
(TCP/IP Module included RJ45 Connector)

s 9
crews or
”l w DMOD-NETMA11
1 (TCP/IP Module with POE function)

o Any Wiegand Output Module (CN10)

Water proof Strip
/\j ®* AR-MDL-721V (Voice Module)
I | AR-321L485-5V (TTL to RS-485 Converter)

AR-837-E/ EE /| ER:LCD Access Controller

@ Products @ Terminal Cables ©® Tools @ Optional
Ethernet : DMOD-NETMA10
_§_C_I’_8_VY§___I"?__ff*fff‘_'f_’_'f_R_ ______ (TCP/IP Module included RJ45 Connector)
or
JJ_L cns Screws g0 837-EE DMOD-NETMA11
132 (TCP/IP Module with POE function)
o Water proof Strip /\_} AR-837.e/ee © Any Wiegand Output Module (CN10)
; Y s I I MM cmmmmmmmmmmemmmoooommmmmmmmmemees AR-MDL-721V (Voice Module)
837-E 837-EE 837-ER J Water proof Strip D 837-ER AR-321L485-5V (TTL to RS-485 Converter)
AR-837-W:LCD Card Energy Saver
@ Products @ Terminal Cables ©® Tools @ Optional

Ethernet : DMOD-NETMA10
(TCP/IP Module included RJ45 Connector)

Screws q@“’) or
_HH/JJJ\ DMOD-NETMA11

1 (TCP/IP Module with POE function)

.

Any Wiegand Output Module (CN10)

Water proof Strip
/\_3 AR-MDL-721V (Voice Module)
oNe J

AR-321L485-5V (TTL to RS-485 Converter)
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